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Chapter 1. Overview of YOPY 

The multimedia PDA YOPY uses the Linux OS developed by G.Mate, Linupy™. With its slim size and 

folder type design, mobility, and high performance, YOPY is capable of providing entertainment contents 

such as images, games or music, and the newest information on the Internet from anywhere at any time.  
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What is in the YOPY box? 

 

Thank you very much for your purchase of the YOPY.  

Please check whether you have all of the following items in the YOPY box. 

 

- YOPY PDA (Model name is “YP3700) 

- Cradle 

- Wireless LAN Card 

- Ear-microphone 

- User Manual 

- CD 

- Fashion Stylus Pen 

- AC Adapter 
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YOPY Outside Components 

 

 

 

 

  

Charge LED 
Charging starts when you put
the YOPY on the cradle 

Red – On charging 
Green – Fully Charged 

Scroll Button 
Recording 

Upper – For starting record 
Lower – For stopping record 

Playing MP3 
Upper – For volume up 
Lower – For volume down 
Moving the scroll bar on the screen
up and down 

IrDA Communication Port 

Slot for MMC or SD Card 

Headphone Jack 
For listening to music with the
Headphone 

Event LED 
The colorful blinking light works 
when you - Open or close the YOPY. 
          - Are reminded with alarm.    

Stylus Pen 

Serial/USB Client Port 
For communicating with PC or charging
the battery by connecting the YOPY to the
cradle. 

CompactFlash Slot 
For wireless LAN card and the
other expansion card. 

 

 
s 

 

[Picture 1-2] YOPY Outside Panel
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YOPY Inside Components 

 

s 

Reset hole 
For doing the soft reset with
the stylus pen.     

Execution Button 
For playing a program or
starting and stopping the MP3
player     

End Button 
For stopping the currently
operating program.     

Send Button 

Power Button 

Speaker 

Microphone 

Navigation Keys 

Key Pad 
Consisting of the letters, the
numbers, the symbols and
other function keys. 
(See Chapter.6 for details) 

Touch Screen 
Touching with the Stylus.
65,536 Colors. 
Front Light.     

 

 

Note. 

For the detailed explanation to t

for the Keyboard use in the Chap

 

[Picture 1-3] YOPY Inside Panel
he way to use the keyboard conveniently and easily, see the guide 

ter 6.  
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Chapter 2. Initial settings of YOPY 

Have you checked all of the components of the YOPY? 

This chapter explains the basic settings you must follow, before using your YOPY for the first time, step by 

step. 
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You should set the YOPY in the following orders before you use it for the first time. 

 

1. Soft reset 

You should tap the Soft Reset Hole (See the Figure. 1-3) with the stylus. 

There appears the “Welcome” screen after the booting screen with the Linux logo (Penguin) shows 

up.  

 

2. ‘Welcome’ Screen 

The YOPY has woken up now! Please tap the screen with the stylus gently. 

 

[Welcome Screen] 

 

3. Calibrate 

Coordinate adjustment lets your YOPY exactly sense the elements on your screen, when 

tapping them with the Stylus.  

Tap the center of the cross mark (    ) on your screen with the Stylus until the screen changes.   

(The new screen shows up after you correctly tap the cross mark in each five different places). 

 

[Calibraton Screen] 
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4. Setting the time 

The below time setting screen follows calibrating. 

You can set the city and the current time and date. You can automatically have the time and the 

date of the city around the world when you choose it.  

 

[Setting Time and Date] 

 

Note 

Please refer to the “Setting the time” in the Chapter 10 for more info
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Chapter 3. MyPIMS 

With the MyPIMS program you can edit, add and delete the data in the PIMS programs of the YOPY such 

as Schedule, Task, and Contact. In addition, MyPIMS has the function of file transfer between the YOPY 

and your PC and one of the PIMS data backup and recovery. 

 

The features of your PC required to install and use the MyPIMS program are as follows: 

 

■ Windows 98SE, Windows 2000, Windows XP, Windows ME, Red Hat 7.1 

■ Pentium II processor or greater 

■ 64MB RAM or more 

■ Available hard disk space more than 150 MB 

■ CD-ROM drive 

■ VGA Monitor or better 

■ Mouse 

■ One USB port 
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Installing MyPIMS  
 

How to install the MyPIMS Program on your PC? 

 

1. Hardware Wizard automatically runs when you put the CD included in the YOPY package into 

the CD-ROM. Click on “MyPIMS Installation” 

 

 

2. Your PC is warming up for installing the MyPIMS program. 

 

 

3. Installing starts with the below screen. Click on the “Next” button. 

 

 

4. The program is automatically installed in the directory of the C drive unless you set a directory 

on the below screen yourself. Click on the “Next” button. 
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5. The installation of the program is on the process. 

 

 

6. Installation has been complete. Click on the “Finish” button. And then, you have MyPIMS Icon 

(      ) on the background. 

 

 

 

 

 11



Connecting the cradle to your desktop PC 
 

Now you can connect the cradle to your desktop PC if you have finished installing the MyPIMS 

program on your desktop PC.  

 

How to connect the cradle to your PC? 

There are the two cables in the cradle. One is for connecting to the power outlet and the other is for 

connecting to the USB port of the PC. Please connect the AC adaptor of the cradle to the power 

outlet and the USB cable of the cradle to the USB port of the PC. 

 

Note. 

After connecting the cradle to the PC, you must install the Device Driver on your PC for the new 

hardware device (USB device). For more information on installing the device driver, see the 

“Installing the Device Driver” part in the following section.. 
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Installing the Device Driver 

You should install the Device Driver on your PC to make it recognize the YOPY. You can, 

therefore, use the MyPIMS program. Please install the driver in the following order. 

 

1. Put the YOPY on the cradle after connecting the USB cable of the cradle to the USB port of 

the PC. 

 

2. The “Found New Hardware Wizard” screen appears when the YOPY is put on the cradle. Click 

on the “Next” button after inserting the CD from the YOPY package in the CD-ROM of your PC. 

 

 

3. You should mark on the box of “Search removable media” and then, click on the “Next” button. 

 

 

4. The installation of the Device Driver is on the process. 
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5. The hardware wizard has finished installing software. Click on the “Finish” button. 

 

 

6. There appears the “Safely Remove Hardware” Icon (    ) on the task bar of the desktop PC 

when the installation of the Device Driver is finished.  

 

Note. 

You should double click on the icon on the bar and then, click on the “Stop” button at the 

below screen before you take the YOPY out of the cradle.  
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Setting the Network  

After installing the Device Driver, you should set the Network for communicating between the PC 

and the YOPY as follows: 

 

1. To open “Network Connections” screen, you should click on “Start->Control Panel-> 

Network Connections” orderly on the desktop PC. Now, select Local Area Connections of 

“ypndis Network Adapter” and then, select “Properties” after pressing the right button of the 

mouse.  

 

2. Now, select “Internet Protocol (TCP/IP)” among the connection items of the “Local Area Connection 

Properties” screen and click on the “Properties” button and then, there appears the “Properties” screen. 

 

 

3. You should set the IP address and the Subnet Mask when you have the “Internet Protocol 

Properties" screen as shown below. As the IP of the YOPY has already been set by  

“192.168.1.2”, you should enter one between “192.168.1.1” and “192.168.1.254” except for 

“192.168.1.2” into the IP address box of the below screen. And enter “255.255.255.0” into the 

Subnet Mask box. And then, click on the “OK” button. 
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You have finished all processes for installing the MyPIMS program and can use it. 

You can see how to edit the PIMS data and how to transfer data between the YOPY and your 

PC at the following part. 
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Using MyPIMS  

MyPIMS runs when you double click on the MyPIMS icon(      ) on the background of the desktop 

PC. 

 

MyPIMS enables you to be able to enter/check/remove the PIMS data of the YOPY on your PC and 

to transfer the data between the YOPY and your PC. You should, therefore, put the YOPY on the 

cradle and turn it on to use MyPIMS. 

 

The initial screen of MyPIMS shows “Today’s Schedule” and “Today’s Tasks”. Also, you can get all 

kinds of information through [Hot Link] and [Download] when your PC is connected to the Internet. 

 

 

 

You can open the item of PIMS on which you want to work when you click on it among the items 

on the menu bar.  

 

Contacts 

You can keep and edit the information on your contact in this item 

Add – You can add a new address. 

Delete – You can remove the address you do not need any more. 

 

Schedule 

You can check the daily/weekly/monthly schedule. You can add a new schedule using the  “Add” 
icon. 

 

 

Tasks 

You can check the tasks. You can add a new task using the  “Add” icon. 

 

File Transfer 

The File Transfer program of MyPIMS makes file transfer possible from the desktop PC to the YOPY or 

vice versa. And it also has the function of the PIMS data backup/restore, Memo Pad. 

You can have the screen showing the data of the YOPY when you click on the “File transfer” 

button on the menu. 

 

Transferring the data from the YOYP to the PC 

1. You should first select the file on the screen you want to transfer and click on the “Transfer to 

PC” button on the right part. 

2. The file can be transferred into the directory of your PC you designated by clicking on the 
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“Save” button. 

 

 

PMS Backup 

You can back up your PIMS data into PC. This make your important data keep safe. 
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Chapter 4 Basic Skills for use of the YOPY 
This chapter describes the basic skills such as the background of the YOPY, operation of the 

program, the battery charge, and a soft rest.  
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The background of the YOPY 
 

The colorful background of the YOPY shows up after you finish the initial setting completely. 

The task bar at the bottom of the screen represents the status of the system. 

T

 

①  Start Menu (  

The various progra

A program execut

Start Menu. 

 

Note. Using Keybo

You can also use t

The program you w

by pressing the Ex

 

② Display Program W

You can see the p

programs at the s

open them.  You c

selecting them. 

 

③ Screen Keyboard Ic

The Screen Keyb

disappears when 

Recognizer by tapp

For more informati

 

 ask Bar 

[Figure 5-1] Background of YOPY 

) 

ms show up when you click on the icon. 

es when you click on it. The below figure show the programs belonging to the 

ard 

he starting button (      ) on the keyboard to let the menu lists show up.  

ant to execute can be selected by the Navigation key and it can be executed 

e button (     ). 

indows Icon (  ) 

rograms that are open currently by tapping the icon. You can execute several 

ame time on the YOPY and also hide them in this icon in order to promptly 

an let the programs hidden in the icon run on the screen tapping the icon and 

on (    ) 

oard or the Handwriting Recognizer shows up when you tap the icon. It 

you tap it again. You can choose the Screen Keyboard or the Handwriting 

ing the Keyboard Shift icon.  

on on how to use the Screen Keyboard, see Chapter 7 Screen Keyboard. 

20



 

④ Screen Keyboard Shift Icon (    ) 

You can select the Screen Keyboard or the Handwriting Recognizer by tapping the icon. 

 

⑤ Input Method Status Icon (    ) 

 

⑥ Multimedia Card (MMC) Icon  

This icon indicates whether the multimedia card is inserted in the Expansion Card Slot or not 

(See Picture 1-3). 

  : The card is inserted. 

  : The card is removed. 

You can see the program for setting the multimedia card when you tap the icon.  

For more detailed information on the program, see the “Card Information” part of Chapter 12.  

 

⑦ Speaker Icon 

This icon indicates the on or off status of the speaker. 

     : The speaker is on. 

     : The speaker is off. 

You can see the program for setting the sound when you tap the icon. 

For more detailed information on the program, see the “Sound Setting” part of Chapter 12. 

 

⑧ Battery Icon 

This icon shows the currently available amount of the battery power. 

      : This indicates that the battery is charging. You can see it when you put the YOPY on the 

cradle being connected to the power outlet. 

                 :  Each icon indicates the remaining amount of the battery power. 

You can see the program for setting consumption of the battery when you tap the icon. 

For more information on the program, see the “Power Setting” part of Chapter 12. 

 

⑨ System Time Icon 

This icon indicates the current time and date. 

The icon shows the time you set in the Time setting program before you turn on the YOPY phone. 

But the exact time supplied by the server of the mobile communication company is indicated when 

you turn on the YOPY phone. 
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Recharging the Battery 
 

The YOPY is automatically recharged when it is put on the cradle connected to the power outlet. 

The Charge LED (See Picture 1-1) is on in a red color while the YOPY is charging, and the color of 

the Charge LED becomes green when the YOPY is fully charged. 

 

Note. When the battery is fully discharged 

You should do the below tips when the YOPY is not turned on due to the complete discharge of the 

battery. 

 

1. Put the YOPY on the cradle for recharging it. 

2. Perform a soft reset when the YOPY is recharged. 

 

You lose all data you have imported on the YOPY when the battery is fully discharged. And so you 

need to periodically back up the imported data in the flash memory of the YOPY not to lose them.  

For information on the back-up, see the “File Transfer” part of Chapter 4 and the “PIMS back-up” 

part of Chapter 8.  

 

 
Resetting the YOPY 
 

You are highly recommended to perform a reset when you have some problems of the system while 

you are operating a program like when a program sticks, when the input of the keyboard does not 

work, and so on. 

You can perform a reset by tapping a reset hole (See Picture 1-1) with a stylus gently. 

The YOPY starts to be rebooted with the screen having a penguin picture, the Linux logo. 

You do not need to worry about the data stored in the YOPY. It is not eliminated even if you perform 

a reset.  
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Chapter 5. the Screen Keyboard & the Handwriting Recognizer 
 

You can enter the letters, the number, and the symbols into the YOPY on the touch screen. This 

chapter describes how to use the programs for entering the written data on the YOY such as “the 

Screen Keyboard” and “the Handwriting Recognizer”. 

For information on setting the Screen Input, see the “Screen Input” part of Chapter 12. 

 

On the Screen Keyboard, you can enter all kinds of the characters into the YOPY tapping each of 

them with the stylus. On the Handwriting Recognizer, you can input data into the YOPY with the 

stylus as you write on the paper.  

 

 

Note. 

Besides the Screen Keyboard and the Handwriting Recognizer, you can enter the various data on 

the YOPY with the Keypad that has the control function as well. You can not only play any programs 

on the YOPY, but also enter the data into the YOPY while being on the car or even while walking on 

the road using the Keypad.   

For more information on the Keypad, see “Using the Keypad” of the Appendix. 
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The Screen Keyboard 

When you would like to enter the characters into a YOPY application program, use the Screen 

Keyboard icon on the task bar at the bottom of the screen. 

The Screen Keyboard shows up as shown at the below picture when you tap the Screen Keyboard 

icon. The Screen Keyboard disappears with one more tap.  

 

B  

E

M

S

S t

k

S t
 

 

The Screen Keyboard can be automatically shown up on the screen 

Keyboard Icon if you mark on the box of “Enable auto hide and rais

“Settings”. 
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The Handwriting Recognizer 

 

You can enter the characters into the screen with the stylus using the Handwriting Recognizer just 

like you write them on the paper.  

You can selectively have the Screen Keyboard or the Handwriting Recognizer using the “Keyboard 

Shift icon (      ) on the task bar of the screen. 

 

F1 

Works as the function 1 

you set at the "Screen 

Input”. 
Back Space 

F2 

Enter Works as the function 2 you

set at the “Screen Input”.  

Space 
F3 (Continuous Writing) 

Works as the function 3 (Continuous

Writing) you set at the "Screen Input”. 
Move 

Keyboard Shift 
Function Setting 

Handwriting Recognizer 
Opens the “Screen 

Keyboard” program for 

setting the new functions.. 

r

 

There are two ways in enterin

Writing” and “Continuous Writi

 

Separate Writing 

 

This box recognizes the data

characters are capital and low

put one character per box and

write in another box or the unit

When you enter an English le

 

[Picture 6-2] Handwriting Recognize
 

g the characters into the Handwriting Recognizer such as “Separate 

ng”. 

 by the unit of one Character. The possible recognized kinds of 

ercase letters of English, numbers and special symbols.  You must 

 the recognition of the character will be completed when you start to 

 time of recognizing process (Unit: 400msec) is passed. 

tter on the box, a capital letter should be written on the capital and 
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lowercase separating line and lowercase letters should be written under this line.  However, the 

written shape of the letter is not used to distinguish whether the letter you enter is capital or not. 
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a capital letter and a small one
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[Picture 6-3] Separate Writin
 

ognition can be done on the 
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[Picture 6-4] Continuous Writing 
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Chapter 6.  Personal Information Management System (PIMS) 

 

This chapter describes how to use the PIMS (Personal Information Management System) program, 

one of the basic functions in the PDA, effectively and efficiently. 

 

The PIMS program is composed of a Contact program, a Task program, and a Schedule program. 

 

In addition, there are a Memo program you can take a short note and a PIMS Back-up program 

where you can store your PIMS data safely. 

 

 

Note. 

 

You can conveniently enter the PIMS data into the PIMS programs of the YOPY using a MyPIMS 

program installed in your PC after putting the YOPY on the cradle connected to your PC.  

For more detailed information on MyPIMS see the “Using MyPIMS” part of Chapter 3. 
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Contact 

 

Menu of Contact View 

Calling 

Sending Message 

New contact 

Editing contact 

Deleting contact 

Searching contact 

All data 

Recent data 

Mobile 

All categories 

By category 

Contact List 

t 

 

Opening Contact Program 

Tap “Start Menu” icon (   ) ⇒ “P

 

Closing Contact Program 

• You can close the contact prog

title bar 

• You can also close the contact

 

Adding a new contact 

• The “Contact Details” screen s

information on the upper part o

• You can open the “Contact De

touching the touch screen.  

 

Editing Contact 

• You can edit the Contact Deta

screen and then, tap the icon (

• You can also open the Contac

(     ) after selecting a person

 

[Picture 7-1] Contact Lis
IMS” ⇒ “Contact” in order 

ram by tapping the closing icon (     ) in the right corner of the 

 program by pressing the End button (     )on the keypad. 

hows up when you tap the icon (     ) for adding new contact 

f the screen.  

tails” screen pressing the “N” (New) key on the keypad without 

ils (Picture 9-2) after you select a person from the Contact List 

     ) from the Menu of Contact.  

t Details screen pressing the Exe button (     ) or the Enter key 

 with the up and down buttons of the Navigation key. 
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Note. Deleting the contact 

You can remove a list on the Contact List (Picture 9-1) tapping the Delete icon (    ) or pressing 

the Del key on the keypad after selecting the list. 

 

 

[Picture 7-2] Contact Details

 

 

Making a phone call on the Contact 

• You can make a call to a contact on the Contact list directly when the CDMA connected to the 

YOPY is on.  

After selecting a contact on the list, tap the calling icon (    ) and then the dial screen shows up 

and it automatically dials the contact. Also, it is possible for you to call a contact pressing the 

Send button after selecting the contact with the up and down button of the Navigation Key. 

You can see all available phone numbers of a contact touching the contact with the stylus for 

about three seconds or pressing the “D” button of the Keypad after selecting the contact. Now 

you can make a phone call to one of those numbers.  (See Picture 7-3) 
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Sending the written m

You can send the mes

has a mobile phone. 

 

 

[Picture 7-3] Looking at the phone numbers of a contac
 

essage in the contact 

sage to a contact on the list, but it is possible only in the case the contact 

 

[Picture 7-4] SMS window 
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Task 

 

Menu of Task View 

New task 

Editing task 

Deleting task 

Searching 

All data 

Recent data 

All categories 

Category 

Uncompleted task 

Completed task 

Title 

Task list 

t 

 

Starting Task Program 

Tap the Start icon (     ) ⇒ Tap 

 

Ending Task Program 

• You can end the Task program

bar.  

• You can also do it pressing the

Creating a record on Task 

• You can open the “Task Detail

sub-screens for entering data.

• You can do the same thing pre

 

Editing Task 

• The “Task Details” screen show

on the list.  

• The “Task Details” screen app

button (    ) on the Keypad 

button of the Navigation Key.  

 

[Picture 7-5] Task Lis
 

PIMS ⇒ Tap Task. 

 tapping the End icon ( ) at the upper right corner of the task 

 End button (   ) on the Keypad.  

s” screen tapping the “New Task” icon (    ) which has the three 

 (See Picture 9-6) 

ssing the “N” key on the Keypad without using the touch screen. 

s up when you tap the Editing icon (     ) after selecting “Task” 

ears as well when you press the Exe button (    ) or the Enter 

after selecting the list you want to edit using the up and down 
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[Picture 7-6] Task Details 
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Schedule 

 

   

w

 

Starting Schedule 

Tap the Start icon (     ) ⇒ Tap P

Ending Schedule Program 

• You can end the Schedule pro

task bar.  

• You can also do it pressing the

 

Creating a record on Schedule 

• You can open the “Schedule D

the three sub-screens for enter

• You can do the same thing pres

 

Editing Schedule 

• The “Schedule Details” screen

the schedule you want to edit

screen.  

• The “Schedule Details” screen

Enter key (   ) on the Keypad

button of the Navigation Key.  

 

[Picture 7-7] Schedule Vie
Daily Schedule
 Monthly Schedule
IMS ⇒ Tap Schedule. 

gram tapping the End icon (

 End button (   ) on the Keypad

etails” screen tapping the “New

ing data.  

sing the “N” key on the Keypad

 shows up when you tap the E

 on the “Schedule” list (Daily

 appears as well when you pr

 after selecting the list you wa
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Yearly Schedule
 

) at the upper right corner of the 

. 

 Schedule” icon (    ) which has 

 without using the touch screen.  

diting icon (     ) after selecting  

 Schedule). You can edit on the 

ess the Exe button (    ) or the 

nt to edit using the up and down 



 

s 

 

 

 

    

 

[Picture 7-8] Schedule Detail
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PIMS Backup 

This program is for keeping your PIMS data on the YOPY safe. If you back up the PIMS data here, 

you can recover the data when you accidentally have lost it by letting the battery fully discharged.  

 

Starting PIMS Backup Program 

Tap the Start icon (     ) ⇒ Tap PIMS ⇒ Tap PIMS Backup. 

 

[Picture 7-9] PIMS Backup 

 

The newest date you backed up the PIMS data and the size of the data are stated on the Backup 

screen.  

 

Backup 

You can back up the PIMS data tapping the “Backup” button after selecting the backup slot.  

 

Recovery 

You can recover the PIMS data tapping the “Recovery” button after selecting the backup slot.  
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Memo 

This program enables you to take a short note at any time.  

 

Starting Memo Program 

Tap the Start icon (     ) ⇒ Tap PIMS ⇒ Tap Memo. 

 

[Picture 7-10] Memo 

You have a list of the memo on the screen and can see the detailed content of a memo pressing 

the Exe button (    ) or the Enter key (     ) after selecting a list. 

 

Recording a memo 

You can take a short and quick note on the screen using the keypad or the screen keyboard. If you 

do not enter a title of the note in the “Detail” screen, the first word of the note automatically shows 

up on the list as a title of the note. 

o

 

[Picture 7-11] Entering Mem
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 Chapter 7. Using Basic Applications 

 

This chapter explains how you can use the various useful programs on the YOPY.  
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Notepad 

 

You can edit or read a document on this program. You can read the files with a “.txt” extension 

transferred from the PC on the program of the YOPY.  

 

Starting Notepad 

Tap the Start icon (     ) ⇒ Tap “YOPY Office” ⇒ Tap “Notepad”. 

 

 

Closing Notepad 

You can close the program by selec

(     ) on the keypad.  

 

Menu 

There are “File”, “Edit”, “Options”, a

You can perform any items on the in

 

The followings are the examples of t

see the “Using the Keypad” in the 

      : Opens the “File” menu. 

Key and you can perform it pressing

   Shft + Navigation Key: Selects the

   Ctrl + 'X'   : Cuts the part yo

 

 

[Picture 8-1] Notepad 

ting “Close” in the “File” menu or by pressing the End button 

nd “Help” on the upper menu bar of the screen. 

side of them using the stylus or the keypad. 

he keypad use. (For the detailed information on the keypad use, 

Appendix)  

You can select what you want to perform using the Navigation 

 the Exe button (     ) 

 range of the lines or the words you want to edit. 

u selected 
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   Ctrl + 'C'   : Copies the part you selected 

   Ctrl + 'V'     : Pastes the part you copied 

 

Opening a document 

You can create a new document af

can open the several files in a row a

 

Editing a document 

You can edit a document convenient

 

Saving a document 

The document can be stored at the

“File” on the menu bar. You can sel

save the document as a file with the 

 

Closing the documents 

You can close the current documen

menu bar. You can also close all op

the menu bar. 

 

Options  

Use Wordwrap – When the line is 

selecting this item

Doc Tabs – The great advantage

 

 

[Picture 8-1] Notepad 

ter tapping the “New” item of the “File” on the menu bar. You 

nd work on each file conveniently.  

ly using the Screen Keyboard or the Keypad. 

 “/root/document/” directory by tapping the “Save” item of the 

ect the other directory if you want. We recommend that you can 

“.txt” extension. 

t on the screen tapping the “Close” item of the “File” on the 

ened documents tapping the “Close All” item of the “File” on 

changed, you can prevent the word from being separated by 

. 

 of the Notepad is that you can have the several opened 
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documents on the same screen. You can either remove the titles of all documents or have all of 

them on the screen by using the “Toggle” item of the Doc Tabs. Also, you can change the 

place of the title into the other places such as “Top”, “Bottom”, “Left”, and “Right”. 

Toolbar – You can have the toolbar under the menu bar when you mark on the box in front of the 

“Toolbar” of the “Options” You can have the more spacious window for entering the data if you do 

not mark on it 
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Recorder 

 

Performing the recording program 

Tap the Start icon(  ) ⇒ Tap “Multimedia” ⇒ Tap “Recorder”. 

 

Ending the recording program 

You can close the program by tapping the “Quit” item of the “File” or by pressing the End button 

(     ) of the Keypad.  

 

Stop recording 

or playing 

Recorded files 

Pause 

Play 
Start recording 

[

Recording and Playing 

You can start recording by tapping the

(  ).  

The recorded file show up on the list of

change the file name by tapping the “Re

You can listen to the recorded file select

 

Note. Using the Scroll Button for easy re

The upper button of the Scroll button: St

The lower button of the Scroll button: Sto

 

Setting a recorder 

 

Picture 8-2] Recorder

 

 record icon (  ) and stop it by tapping the stop icon 

 the screen immediately you finish recording. You can also 

name” of the “File” and by entering a new name. 

ing it and pressing the “Play” icon (  ) 

cording 

art recording 

p recording 
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You have the following screens for setting the recorder when you tap the “Configure” on the menu 

bar. 

 

[Picture 8-3] Setting a recorder

 

Recording can be automatically stopped at the recording time or by the recording size you set.  
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MP3 Player 

 

You can listen to the MP3 file downloaded from the PC on this program. You can enjoy the music 

while you are performing the other program. 

 

Starting the MP3 Player 

Tap the Start icon (      ) ⇒ Tap “Multimedia” ⇒ Tap “MP3 Player”. 

 

Closing the MP3 Player 

You can close the MP3 Player tapping the “Close” icon ( x ) or pressing the End button (     ) of 

the Keypad. 

 

Features of the MP3 Player   

 

Previous song Skin Setting 

For selecting the design of

the MP3 Player or for setting

the interval between the

songs. (See Picture10-6) 

Pause 

Play 
Played time 

File managementTitle 
For add a song in the

MP3 Player or for

removing a song from

it. (See Picture 10-5) 

Repeat 

Seek bar Stop 

Volume 
Next song 

Listen randomly

[

You can also use the Keypad buttons fo

 

Picture 8-4] MP3 Player 

r performing the MP3 player instead of using the stylus. 
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Exe button: Plays the current song. You can stop playing with one more press of it. 

End button: Closes the MP3 Player program. 

Left button of the Navigation Key: Selects the previous song. 

Right button of the Navigation Key: Selects the next song. 

Scroll button: Adjusts the volume. 

 

  

[Picture 8-5] Adding/Removing the files [
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Picture 8-6] Setting the skin of the MP3 Player 

  



Painter 

 

You can draw pictures on this screen as you do on the sketchbook. And you can take a look at the 

picture or the drawing on the screen you downloaded from the PC.  

 

Performing the Painter 

Tap the Start icon (    ) ⇒ Tap “Multimedia” ⇒ Tap “Painter”. 

 

Closing the Painter 

You can close the program by tapping the “Close” item of the “File” or by pressing the End button 

of the Keypad.  

 

 

Menu bar 
Palette icon 

Tool icon 

Drawing tool 

Palette 

 

Drawing 

You can have the “New Canvas” s

File” of the “File” as shown in the

but you can set the size of the pict

Duplicating the current screen 

You can duplicate the current scre

on the menu bar.  

Making the background 

 

 

[Picture 8-7] Painter 

creen for setting the size of the picture when you tap the “New 

 Picture 10-8. By default, it is set by 320 x 240 (Height x Width) 

ure as you want on the screen.  

en on the painting screen by tapping “Get Desktop” of the “File” 
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You can use the current picture on the painter as the background of the YOPY by tapping the “Set 

as background” of the “File” on the menu bar (See Picture 10-9). You can get back the original 

background by tapping the Start icon  “Restart”  “Restart Icewm” in order. 

 

[Picture 8-8] New Canvas 

 

 

Opening the picture on the painter 

Tapping “Set as background”
Of the “File” on the menu bar

Newly created background 

[Picture 8-9] Making the background 

 

Edit Menu 

You can edit the picture on the painter with the items such as “Cut”, “Copy”, “Paste”, “Clear” 

and ”Select All” that are in the “Edit” menu. 
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Filter Menu 

You can add the effects of the various images into the whole picture or into the part of the picture 

with the items of the “Filter” menu. 

 

Drawing Tools 

The following drawing tools show up whey you tap the “Tool” icon on the menu bar. 

Tools Description Tools Description 

 Eraser  폐곡선으로 영역 선택하기 

 Drawing polygon  Entering data 

 Painting  Drawing arc 

 Drawing the straight line  Drawing circle 

 Connecting the lines   

 Drawing the quadrilateral   

 

Drawing curved circle 

 
  

 Selecting the font   

 

Palette 

You have the palette with many colors at the bottom of the screen when you tap the Palette icon. 

You can paint the color of the front and the background freely as you want. The color of the front 

represents the color of the drawing or of the part you are drawing and one of the background 

stands for the color of the whole screen.  
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Background 

 

You can have a picture or a drawing you like on the background of the YOPY using the wallpaper 

program. 

 

 

[Picture 8-11] Setting background 

 

You can make the several pictures on the background show up in a row with the steady interval. 

1. You can add the picture by tapping the “Add” button. 

(You can remove the picture by tapping the “Del” button after selecting the picture you 

want to delete.) 

2. You can set the time changing from one picture to another one. 

3. You can set the brightness. 

4. The added pictures are set as the backgrounds when you tap the “OK” button. 

 

Note. Making the background with the painter 

You can also set the background using the “Making background” on the “File” menu of the Painter 

program. 

For more information, see the “Painter” part of Chapter 11 Using basic applications.
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Package Manager 

 

You can use this program to install and to remove the applications. For instance, you can install the 

game on the YOPY very conveniently using this program. 

 

Starting the package manager 

Tap the Start icon (    ) ⇒ Tap “Utilities” ⇒ Tap “Package Manager”. 

 

Installing a program 

 

1. You should first download the program (the file with the “.rpm” extension) you want to install to 

the YOPY. You can download the programs on the YOPY site (www.yopy.com). 

 

2. Tap “Install” of the “Operations” menu on the package manager screen. 

 

 

3. The “Install” screen shows up. You have to find the rpm file you downloaded after tapping the 

“Add” button. 
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4. You should tap the “Install” button on the bottom of the screen after adding the file and then, 

the program is installed. You can see the name of the program and progress of installation. 

 

 

5. You can check it on the Start Menu that the program is installed and perform it. 

 

Removing a program 

 

1. You have to open the package manager screen and select a directory in the Directory box 

that includes a program you want to remove. Now you have the program icons in the 

Program icon box. Just select the program(s) you want to remove there. 
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2. The questioning screen pops up when you tap the “Uninstall” of the “P

the package manager screen. Just tap the “Yes” button to remove the s
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ackages” menu on 

elected program.  



File Manager 

 

You can use the File Manager for managing the directories and the files of the YOPY. You can 

delete, copy, paste, move, compress, and partition the file(s) freely with this program. 

 

Starting the file manager 

Tap the Start icon (    ) ⇒ Tap “File Manager” 

Menu Bar 

Tool Bar 

List Title 

[

There are the functions moving/copying

registered information in the File Manager

The followings are concerning the menu o

 

File Menu 

“New”  For creating a new 

“Open”  For opening a file. 

“Open with” For selecting a progra

“Delete”  For removing a file or 

“Symlink” The “Symlink” has a s

  For the detailed inform

“Quit”  For closing the progra

 

Note. Symlink 

It works as the “Link” of the Windows d

“Symlink” as follows: 

 

 

Picture 8-10] File Manager 

/pasting/deleting the file(s) and the function viewing the 

. 

f the File Manager 

directory or a new file in the current directory. 

m on which you want to perform a file. 

a directory. 

imilar function as the “Link” of the Windows. 

ation, see the below note. 

m. (You can also use the End button of the Keypad.). 

oes. Let’s try to link “/mnt/mmc” to “/home/root” using 
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① Select the “mmc” directory under the “/mnt” directory. 

② You have the pop-up screen as shown below when tapping “Symlink” 

 

③ Type “/home/root/mmc_link” in the box. 

The “mmc_link” is only the name of the Symlink you designate. If you type just the path 

without it (ex: /home/root/), a directory with the original name, “mmc”, is created in the 

directory of the path you entered. 

④ You can finish “Symlink” by tapping the “OK” button. 

⑤ You can see the newly created “mmc_link” directory in the File Manager. And you can move 

into the “/mnt/mmc” directory directly by tapping the new directory. 

 

Edit Menu 

There are the functions for editing a directory or a file such as “Copy”, “Cut”, “Paste”, “Property” 

and “Select All”. 

You can set the information on a file or a directory and authorization for using a file in the 

“Property”. In the “Property”, “R” stands for the right for reading, ”W” for writing, and “X” for 

executing. 
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[

Commands Menu 

Find For searching a file o

find. If you cannot re

all files or all directori

gzip For compressing a fi

the “gzip” of “Comm

file in the current dire

tar For binding the files 

more than two by ta

create a new file or a

 

Settings Menu 

 

You can make “Toolbar”, “List

be hidden using the items of th

 

 

Picture 8-11] Properties of a file or a directory 

   

r a directory. Just enter the name of a file or a directory you want to 

call the full name of a file, use the wild card (*). That is, you can see 

es having “m” as a initial of their names when you enter “m*” 

le or a directory. You can compress a file or a directory by tapping 

ands Menu” after selecting it. You can uncompress the compressed 

ctory by double tapping it or by opening it.  

or the directories into one. You can bind the files or the directories 

pping “tar” of “Commands Menu” after selecting them. You can 

 new directory after entering the name of it. 

 titles”, “Status bar”, or “.Files” to be shown up on the screen or to 

e Settings Menu.  
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FCC Statement 

  

This device complies with part 15 the FCC Rules. Operation is subject to the 

following two conditions: 1) This device may not cause harmful interference, and 2) 

this device must accept any interference received, including interference that may cause 

undesired operation. 

   

Caution: Any changes or modifications in construction of this device which are not 

expressly approved by the party responsible for compliance could void the user’s 

authority to operate the equipment. 

   

Note: This equipment has been tested and found to comply with the limits for a Class B 

digital device, pursuant to part 15 of the FCC Rules. These limits are designed to 

provide reasonable protection against harmful interference in a residential installation. 

This equipment generates, uses and can radiate radio frequency energy and, if not 

installed and used in accordance with the instructions, may cause harmful interference 

to radio communications, However, there is no guarantee that interference will not 

occur in a particular installation. If this equipment does cause harmful interference to 

radio or television reception. Which can be determined by turning the equipment off and 

on, the user in encouraged to try to correct the interference by one or more of the 

following measures: 

- Reorient or relocate the receiving antenna 

- Increase the separation between the equipment and receiver. 

- Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected. 

- Consult the dealer or an experienced radio/TV technician for help. 

  

  




